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  

MULTIMEDIA AND  
DESKTOP PUBLISHING 1

Chapter

1

Evaluation
Part - I

Choose the correct answer

1.	 ________ refers to any type of application that 
involves more than one type of media such as 
text, graphics video animation and sound.
(a)	 an executable file� [Govt. MQP-2019]
(b)	 desktop publishing
(c)	 multimedia		
(d)	 hypertext� [Ans. (c) multimedia]

2.	 One of the disadvantages of the multimedia is 
its __________.
(a)	 cost			   (b)	 adaptability
(c)	 usability			  (d)	 relativity

� [Ans. (a) cost]
3.	 Expand JPEG 

(a)	 Joint Photo Experts Gross
(b)	 Joint Photographic Experts Group
(c)	 Joint Processor Experts Group
(d)	 Joint Photographic Expression Group

� [Ans. (b) Joint Photographic Experts Group]

4.	 You need hardware, software and ________ to 
make multimedia.
(a)	 network		      (b)	 compact disk drive
(c)	 good idea
(d)	 programming knowledge

� [Ans. (b) compact disk drive]
6.	 Find the odd one on the following which is not 

an image format
(a)	 TIFF	 (b)	 BMP
(c)	 RTF 	 (d)	 JPEG� [Ans. (c) RTF]

8.	 The live telecasting of real time program 
through Internet is known as ____� [HY-2019]
(a)	 web casting		  (b)	 web hosting
(c)	 data manipulation	 (d)	 none of the above

� [Ans. (a) web casting]

9.	 GIF use _______ color look up table
(a)	 8 bit			   (b)	 13 bit
(c)	 8 MB			   (d)	 13 MB

� [Ans. (b) 13 bit]

10.	 RTF file format was introduced by ______
(a)	 TCS			   (b)	 Microsoft
(c)	 Apple			   (d)	 IBM

� [Ans. (b) Microsoft]

Part - II

Short Answers

1.	 Define Multimedia and their features.�  
� [Sep-2020]

Ans. (i)	 The word multimedia consists of two 
words “multi” and “media” which means 
that multiple forms of media are combined 
to gather and provide services like storage, 
communication, presentation and Input/ 
output interactions of text, video, image, 
graphics and audio.

Features of Multimedia :
(i)	 The information they handle is represented 

digitally.
(ii)	 Multimedia systems are integrated 

computer controlled and usually 
interactive.
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6.	 List out image file formats.
Ans. (i)	 TIFF	– Tagged Image File Format

(ii)	 BMP	– Bitmap
(iii)	 DIB	 – Device Independent Bitmap
(iv)	 GIF	 – Graphic Interchange Format
(v)	 JPEG – Joint Photographic Experts Group
(vi)	 TGA	– Tagra
(vii)	 PNG	– Portable Network Graphics

7.	 List out audio file formats.� [Govt. MQP-2019]
Ans. (i)	 WAV	– Wave form Audiofile   Format

(ii)	 MP3	– MPEG Layer - 3 Format
(iii)	 OGG
(iv)	 AIFF	– Audio Interchange File Format
(v)	 WMA – Windows Media Audio
(vi)	 RA	 – Real Audio Format

8.	 List out video file formats.
Ans. (i)	 AVI	 – Audio / Video Interleave

(ii)	 MPEG – Moving Picture Experts Group

9.	 Define Multimedia Production.
Ans. (i)	 In the multimedia application, after the 

pre-production activities, the production 
phase starts. This phase includes the 
activities like background music selection, 
sound recording and so on.

(ii)	 Text is incorporated using OCR software, 
Pictures shot by digital camera, Video clips 
are shot, edited and compressed.

10.	 List out Multimedia Production team 
members.

Ans.	The team comprises of members playing various 
roles and responsibilities like Script writer, 
Production manager, Editor, Graphics Architect, 
Multimedia Architect and Web Master.

Part - III

Explain in Brief Answer

3.	 Write roles and responsibilities of Production 
team members.

Ans. (i)	 Production Manager: In a multimedia 
production, the role of production manager 
is to define, and coordinate, the production 
of the multimedia project in time and with 
full quality. 

(ii)	 Content Specialist: Content specialist is 
responsible for performing all research 
activities concerned with the proposed 
application’s content.

(iii)	 Script Writer: The script writer visualizes 
the concepts in three dimensional 
environments and if needed uses the virtual 
reality integration into the program.

(iv)	 Text Editor: The Text Editor checks 
the flow of text, structure and correct it 
grammatically.

(v)	 Multimedia Architect: The multimedia 
architect integrates all the multimedia 
building blocks using an authoring tools.

4.	 Describe the various file formats in 
multimedia.� [HY-2019]

Ans. (i)	 Text File Formats
(a)	 RTF(Rich Text Format) 
(b)	 Plain text

(ii)	 Image File Formats 
(a)	 TIFF (Tagged Image File Format) 
(b)	 BMP (Bitmap)
(c)	 DIB (Device Independent Bitmap)
(d)	 GIF (Graphics Interchange Format)
(e)	 JPEG (Joint Photographic Experts 

Group)
(f)	 TGA (Tagra)
(g)	 PNG (Portable Network Graphics)

(iii)	 Digital Audio File Formats
(a)	 WAV (Waveform Audio File Format)
(b)	 MP3 (MPEG Layer-3 Format)
(c)	 OGG
(d)	 AIFF (Audio Interchange File 

Format)
(e)	 WMA (Windows Media Audio)
(f)	 RA (Real Audio Format)

(iv)	 Digital Video File Formats
(a)	 AVI (Audio/Video Interleave)
(b)	 WMV (Windows Media Video)
(c)	 FLV (Flash Video)
(d)	 3GP
(e)	 MPEG (Moving Picture Experts 

Group)
5.	 Explain animation industry and their scope.
Ans. (i)	 The Indian animation industry encompasses 

traditional 2D animation, 3D animation and 
visual effects for feature films. 

(i)	 In 1956, Disney studios animator clair weeks 
who had worked on Bambi, was invited 
to Films Division of India in Mumbai 
to establish and train the country's first 
animation studio as part of the American 
technical co-operation mission.
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(ii)	 Indian animation industry is anticipated 
to grow faster than the IT industry.

(iii)	 The industry has grown to a multibillion 
net worth standard.

(iv)	 The manpower crunch needs to be 
decreased with animators.

(v)	 There are hundreds and thousands of 
job opportunities lying around open for 
animators.

(vi)	 Work opportunities for quality animators 
and related professionals exist in the 
following sectors :-
(a)	 Advertising
(b)	 Online and Print News Media
(c)	 Film & Television
(d)	 Cartoon production
(e)	 Theater
(f)	 Video Gaming
(g)	 E-learning

Part - IV

Explain in Detail:
1.	 Explain in detail Process of Multimedia.�

� [QY-2019; Sep-2020]

Ans.	Following are the phases for development of 
complex multimedia projects.
(1)	 Conceptual Analysis and Planning :

(i)	 The process of multimedia making 
begins with a conceptual ignition 
point.

(ii)	 Conceptual analysis identifies a 
appropriate theme, budget and 
content availability on that selected 
theme.

(iii)	 Additional criteria like copyright 
issues also are considered in this 
phase.

(2)	 Project design :
(i)	 Once the theme is finalized objectives, 

goals, and activities are drawn for the 
multimedia project. 

(ii)	 General statements are termed as 
goals. The specific statements in the 
project is known as the objectives.

(iii)	 Activities are series of actions 
performed to implement an objective. 
These activities contribute to the 
Project design phase.

(3)	 Pre-production :
	� Based on the planning and design, it is 

necessary to develop the project.
(4)	 Budgeting : 
	 Budgeting for each phases like consultants, 

hardware, software, travel, communication 
and publishing is estimated for all the 
multimedia projects.

(5)	 Multimedia Production Team :
(i)	 The production team for a high end 

multimedia project requires a team 
efforts. 

(ii)	 The team comprises of members 
playing various roles and 
responsibilities like Script writer, 
Production manager, Editor, Graphics 
Architect, Multimedia Architect and 
Web Master.

(6)	 Hardware/Software Selection :
(i)	 All multimedia Application requires 

appropriate tools to develop and 
playback the application. 

(ii)	 Hardware includes the selection of 
fastest CPU, RAM and huge monitors, 
sufficient disc for storing the records.

(7)	 Preparing the structure:
(i)	 A detailed structure must have 

information about all the steps.
(ii)	 This structure defines the activities, 

responsible person and the start/end 
time for each activity.

3.	 Explore the opportunities Animation filed 
movie industry.� [QY-2019]

Ans. (i)	 In the past, students that complete an 
animation course or a visual effects course 
could find job opportunities only in the 
film industry.

(ii)	 In India, the VFX domain, or the animation 
and visual effects industry, has been 
growing stronger and stronger in recent 
years.

(iii)	 Animation and visual effects requirements 
for massive international projects such 
as HBO’s top TV series and Marvel’s 
hits Infinity War and Black Panther 
was outsourced to Indian companies in 
Mumbai and Pune.
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(iv)	 The surge in demand for animation and 
visual effects experts has led to a significant 
increase in the number of students 
enrolling for a VFX course.

(v)	 As such, a student that completes a 3D 
animation course can hope to build a 
rewarding and satisfying career in the 
Media and Entertainment field these days.

(vi)	 The timeless classics Tom and Jerry and 
Mickey Mouse created a milestone but the 
legacy is not disappointing.

(vii)	 Indian animation has risen from an amateur 
piece of craft like “The Banyan Deer” to the 
million rupees project “Chhota Bheem”.

(viii)	POGO, the leading cartoon channel in 
India is the most successful entertainment 
channel for kids.

(ix)	 Indian animation industry is anticipated to 
grow faster than the IT industry.

(x)	 The industry has grown to a multibillion 
net work standard.

(xi)	 As a result of the growing demand in 
industry, the scope of animation course in 
tremendous.

(xii)	 The number of VFX artists and animators 
that worked on Baahubali was around 750.

(xiii)	Ex. For Top animates Movies : Spider-Man, 
Incredibles 2, Zootopia, Inside Out, Toy 
Story 3, Finding Nemo, Frozen, etc.

4.	 Explain in detail about production team Roles 
and Responsibilities.� [HY-2019]

Ans.	Production Manager:
(i)	 In a multimedia production, the role of 

production manager is to define, and coordinate, 
the production of the multimedia project in 
time and with full quality. 

(ii)	 The production manager should be an expertise 
in the technology expert, good at proposal 
writing, good communication skills and 
budget management skills.

(iii)	 Also must have experience in human resource 
management and act as an efficient team leader.

Content Specialist :
(i)	 Content specialist is responsible for performing 

all research activities concerned with the 
proposed application’s content.

(ii)	 Program content refers to projects information, 
graphics, data or facts presented through the 
multimedia production.

Script Writer :
(i)	 Video and film scripts represents a linear 

sequence of events.
(ii)	 The script writer visualizes the concepts in 

three dimensional environments and if needed 
uses the virtual reality integration into the 
program.

Text Editor : 
(i)	 The content of a multimedia production always 

must flow logically and the text should always 
be structured and correct grammatically.

(ii)	 Text and narration is an integrated part of 
the application.

Multimedia Architect :
The multimedia architect integrates all the multimedia 
building blocks like graphics, text, audio, music, 
video, photos and animation by using an authoring 
software.
Computer Graphic Artist :
The role of Computer Graphic Artist is to deal 
with the graphic elements of the programs like 
backgrounds, bullets, buttons, pictures editing, 
3-D objects, animation, and logos etc.
Audio and Video Specialist :
(i)	 The roles of these specialists are needed for 

dealing with narration and digitized videos 
to be added in a multimedia presentation. 

(ii)	 They are responsible for recording, editing 
sound effects and digitizing.

5.	 Explain about different file formats in multimedia 
files.� [Mar-2020]

Ans.	File Formats for Multimedia : The following 
is an outline of current file formats used for the 
production and delivery of multimedia data.
(1)	 Text Formats:
	 RTF :
		� Rich Text Format is the primary file format 

introduced in 1987 by Microsoft with the 
specification of their published products and 
for cross-platform documents interchange.

	 Plain text :
	 (i)	� Plain text files can be opened, read, 

and edited with most text editors.
	 (iii)	� Commonly used are Notepad (Windows), 

Gedit or nano (Unix, Linux), TextEdit 
(Mac OSX) and so on.

(2)	 Image Formats :
		 TIFF (Tagged Image File Format) :
	 (i)	� This format is common in desktop 

publishing world (high quality output), 
and is supported by almost all software 
packages.
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	 (ii)	 �Recent versions of TIFF allows 
image compression, and the format 
is comfortable for moving large files 
between computers.

DIB (Device Independent Bitmap) :
This format which is similar to BMP, allows the 
files to be displayed on a variety of devices.
GIF (Graphics Interchange Format) :
(i)	 GIF is a compressed image format. Most of 

the computer color images and backgrounds 
are GIF files.

(ii)	 This file format is best suitable for graphics 
that uses only limited colors, and it is the 
most popular format used for online color 
photos.

TGA (Tagra) :
It is the first popular format for high-resolution 
images. TGA is supported by Most of the video-
capture boards.
PNG (Portable Network Graphics) :
(i)	 An extensible file format for the less loss, 

portable and well compressed storage of 
raster images.

(ii)	 PNG acts as replacement for GIF and also 
replaces multiple common uses of TIFF. 

(3)	 Digital Audio File Formats :
WAV (Waveform Audio File Format)
(i)	 WAV is the most popular audio file format 

in windows for storing uncompressed sound 
files.

(ii)	 In order to attain the reduced file size it can also 
be converted to other file formats like MP3.

MP3 (MPEG Layer-3 Format) :
(i)	 MPEG Layer-3 format is the most popular 

format for storing and downloading music.
(ii)	 The MP3 files are roughly compressed to 

one-tenth the size of an equivalent WAV file.

(4)	 Digital Video File Formats :
AVI (Audio/Video Interleave) :
	 AVI is the video file format for Windows. 

Here sound and picture elements are stored 
in alternate interleaved chunks in the file.

MPEG (Moving Picture Experts Group) : 
(i)	 MPEG is a standard for generating digital 

video and audio compression under the 
International Standards Organization (ISO) 
by the group of people. 

(ii)	 Simply MPEG is the standards for digital 
video and audio compression.

government exam questions and answers

Choose the Correct Answer� 1 MARK

1.	 In which of the following pair / pairs is/are 
wrong� [QY-2019]
	1)	 DIB ----- �Allows the files to be displayed 

on a variety of devices
	2)	 RA -----  �It is designed for streaming audio 

over the internet
	3)	 RTF -----Introduced by APPLE
	4)	 TGA ----- �It is supported by most of the 

video capture boards
(a)	 both 1 and 2 	
(b)  both 2 and 3
(c)	 3 only 		
(d)  4 only� [Ans. (c) 3 only]

2.	 Which is not an image format?� [Sep-2020]
(a)	 AIFF			   (b)	 GIF	
(c)	 TIFF			   (d)	 JPEG�
� [Ans. (a) AIFF]

Very Short Answers� 2 MARKS
1.	 Write roles and responsibilities of computer 

programmer.� [QY-2019]
Ans. (i)	 The computer programmer writes the lines of 

code or scripts in the appropriate language. 
(ii)	 These scripts usually develops special functions 

like developing the software to give the size 
and shape of video windows, controlling 
peripherals and so on.


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An Introduction to  

Adobe Pagemaker 2
Chapter

6

Evaluation

Part - I

Choose the correct answer

2.	 ____________ is a DTP software.
(a)	 Lotus 1-2-3		  (b)	 PageMaker
(c)	 Maya			   (d)	 Flash
� [Ans. (b) Pagemaker]

6.	 A __________ tool is used for magnifying the 
particular portion of the area.
(a)	 Text tool 		  (b)	 Line tool
(c)	 Zoom tool 		  (d)	 Hand tool

� [Ans. (c) Zoom tool]

7.	 _________ tool is used for drawing boxes.
(a)	 Line			   (b)	 Ellipse
(c)	 Rectangle		  (d)	 Text

� [Ans. (c) Rectangle]

8.	 Place option is present in _________ menu.
(a)	 File			   (b)	 Edit
(c)	 Layout			   (d)	 Window

� [Ans. (a) File]

10.	 Character formatting consists of which of the 
following text properties?
(a)	 Bold			   (b)	 Italic
(c)	 Underline		  (d)	 All of these

� [Ans. (d) All of these]

12.	 Shortcut to print a document in Pagemaker is 
___________
(a)	 Ctrl + A			   (b)	 Ctrl + P
(c)	 Ctrl + C			   (d)	 Ctrl + V

� [Ans. (b) Ctrl + P]

13.	 Adobe PageMaker is a ___________ software.
� [Ans. Page layout]
16.	 ________ tool is used to draw a circle.
� [Ans. Ellipse]
17.	 The Insert pages option is available on clicking 

the _________ menu.� [Ans. Layout]

Part - II

Short Answers

7.	 Differentiate Ellipse tool from Ellipse frame 
tool.

Ans.	 Ellipse 
tool

Ellipse tool Used to draw circles and ellipses.

Ellipse frame tool Used to create elliptical placeholders for 
text and graphics.

Ellipse tool Used to draw circles and ellipses.

Ellipse frame tool Used to create elliptical placeholders for 
text and graphics.

Used to draw 
circles and ellipses.

Ellipse 
frame tool

Ellipse tool Used to draw circles and ellipses.

Ellipse frame tool Used to create elliptical placeholders for 
text and graphics.Ellipse tool Used to draw circles and ellipses.

Ellipse frame tool Used to create elliptical placeholders for 
text and graphics.

Used to create 
elliptical 
placeholders for 
text and graphics.

9.	 What is text block?
Ans.	A text block contains text you type, paste, or 

import. The borders of a text block cannot be 
seen until it select with the pointer tool.

10.	 What is threading text blocks?�
� [Govt. MQP-2019]

Ans.	A Text block can be connected to other text 
block so that the text in one text block can flow 
into another text block. Text blocks that are 
connected in this way are threaded.

11.	 What is threading text?
Ans.	The process of connecting text among Text 

blocks is called threading text.

This is Only for Sample for Full Book order Online or Available at All Leading Bookstores

orders@surabooks.com Ph:9600175757 / 8124201000

www.su
ra

bo
ok

s.c
om



7

 Sura’s ➠ XII Std - Computer Applications

A
n 

In
tr

od
uc

ti
on

 t
o 

A
do

b
e 

Pa
ge

m
ak

er

12.	 How do you insert a page in PageMaker?
Ans.	To insert pages

(i)	 Go to the page immediately before the page 
to be inserted.

(ii)	 Choose Layout →Insert Pages in the menu 
bar. The Insert Pages dialog box appears.

(iii)	 Type the number of pages want to be insert. 
(iv)	 To insert pages after the current page, 

choose 'after' from the pop-up menu.
(v)	 Click on Insert.
(vi)	 The new pages are inserted in publication.

Part - III

Explain in Brief Answer

1.	 What is PageMaker? Explain its uses.
Ans. (i)	 Adobe PageMaker is a page layout software. 

(ii)	 It is used to design and produce documents 
that can be printed.

(iii)	 A simple business card to a large book can 
be created.

(iv)	 Page layout software includes tools that 
allows to easily position text and graphics 
on document pages. For example, using 
PageMaker, create a newsletter that includes 
articles and pictures on each page. 

(v)	 Pictures and text next to each other, on top 
of each other, or beside each other can be 
placed.

4.	  How do you rejoin split blocks?
Ans.	To rejoin the two text blocks

(i)	 Place the cursor on the bottom handle of 
the second text block, click and drag the 
bottom handle up to the top.

(ii)	 Then place the cursor on the bottom handle 
of the first text block, and click and drag the 
bottom handle down if necessary.

5.	 How do you link frames containing text?
Ans.	To link Frames containing text

(i)	 Draw a second frame with the Frame tool 
of your choice.

(ii)	 Click the first frame to select it.
(iii)	 Click on the red triangle to load the text icon.
(iv)	 Click the second frame. PageMaker flows 

the text into the second frame.

6.	 What is the use of Master Page?�  
� [QY-2019; Mar-2020]

Ans. (i)	 Any text or object that you place on the master 
page will appear on the entire document 
pages to which the master is applied. 

(ii)	 It shortens the amount of time because 
you don't have to create the same objects 
repeatedly on subsequent pages.

(iii)	 Master pages commonly contain repeating 
logos, page numbers, headers and footers.

7.	 How to you insert page numbers in Master 
pages?

Ans. (i)	 Click on Master Pages icon.
(ii)	 Then click on Text Tool. Now the cursor 

changes to I - beam.
(iii)	 Then Click on the left Master page where 

you want to put the page number.
(iv)	 Press Ctrl + Alt + P.
(v)	 The page number displays as ‘LM’ on the 

left master page.
(vi)	 Similarly click on the right Master page 

where you want to put the page number.
(vii)	Press Ctrl + Alt + P.
(viii)The page number displays as ‘RM’ on the 

right master page, but will appear correctly 
on the actual pages.

Part - IV
Explain in detail

2.	 Write the steps to place the text in a frame.
Ans.	To place text in a Frame

(i)	 Click on one of a Frame tool from the 
Toolbox.

(ii)	 Draw a frame with one of PageMaker’s 
Frame tools (Rectangle frame tool or 
Ellipse Frame Tool or Polygon frame Tool). 
Make sure the object remains selected.

(iii)	 Click on File. The File menu will appear.
(iv)	 Click on Place. The Place dialog box will 

appear.
(v)	 Locate the document that contains the text 

you want to place, select it. 
(vi)	 Click on Open.
(vii)	Click in the frame to place the text in it. The 

text will be placed in the frame.

3.	 How can you convert text in a text block to a 
frame? � [QY-2019]

Ans.	Converting text in a text block to a frame:
After creating a text in the text block, to convert 
it to a frame. It can be done by using these steps.
(i)	 Draw the frame of your choice using one of 

the PageMaker’s Frame tool.
(ii)	 Select the text block you want to insert in 

the frame.

7
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(iii)	 Click the frame while pressing the Shift 
key. Now both elements will be selected.

(iv)	 Choose Element → Frame → Attach 
Content on the Menu bar.

(v)	 Now the text appears in the frame.

4.	 Write the steps to draw a star using polygon 
tool?� [Sep-2020]

Ans.	Drawing a star using polygon tool:
To draw a Star
(i)	 Click on the Polygon tool from the toolbox. 

The cursor changes to a crosshair.

(ii)	 Click and drag anywhere on the screen. As 
you drag, a Polygon appears.

(iii)	 Release the mouse button when the Polygon 
is of the desired size.

(iv)	 Choose Element → Polygon Settings in the 
menu bar. Now Polygon Settings dialogue 
box appears.

(v)	 Type 5 in the Number of sides text box.
(vi)	 Type 50% in Star inset textbox.
(vii)	Click OK. Now the required star appears on 

the screen.

government exam questions and answers
Choose the Correct Answer� 1 MARK

1.	 A ______ dialogue box appears when double 
click the line tool from the page maker tool 
box.� [QY-2019]
(a)	 Rounded Corners	
(b)	 Custom stroke
(c)	 Polygon Settings	
(d)	 Go to page� [Ans. (b) Custom stroke]

2.	 Shortcut to fetch a pointer Tool in PageMaker:
� [Sep-2020]
(a)	 F2			   (b)	 F5	
(c)	 F7			   (d)	F9
� [Ans. (d) F9]

3.	 _______ Command is used to show the ruler 
in PageMaker.� [Sep-2020]
(a)	 View → Ruler		
(b)	 Show → Ruler
(c)	 View → Show Rulers	
(d)	 None� [Ans. (d) View → Ruler]

Very Short Answers� 2 MARKS

1.	 How will you delete text in PageMaker file?  
� [Mar-2020]

Ans.	To delete a character, do the following :
(i)	 Position the insertion point to the left of 

the character to be deleted.
(ii)	 Press Delete key on the keyboard.

2.	 How to resize a Text Block in PageMaker? 
� [Sep 2020]

Ans.	When a text block is selected with the Pointer 
tool, the block's boundaries become visible. Two 

handles are seen above and below the text block. 
These handles are called Windowshades. There 
is a dark square on both ends of the handle. These 
are used to change the size of the text block.

Explain in Brief A nswer� 3 MARKS
1.	 How will you magnify a page in pagemaker?

� [Govt. MQP-2019]
Ans.	To magnify or reduce with the zoom tool :

(i)	 Select the zoom tool. The pointer becomes 
a magnifying glass with a plus sign in its 
center, indicating that the zoom tool will 
magnify your view of the image. �  
(The magnifying glass shows a minus sign 
in its center when in reduction mode.) 
To toggle between magnification and 
reduction, press the Ctrl key.

(ii)	 Position the magnifying glass at the 
center of the area you want to magnify or 
reduce, and then click to zoom in or out. 
Continue clicking until the publication is 
at the magnification level you want. When 
the publication has reached its maximum 
magnification or reduction level, the center 
of the magnifying glass appears blank.

2.	 How to save PageMaker Archives?� [HY-2019]
Ans.	Saving a document allows you to review later 

and edit the document. Saved file can be used on 
other computer also. To save a document for a 
first time following steps are used:
(a)	 Choose File > Save in the menu bar. (or)
	 Click on the Save icon( ) in the Tool bar. 


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Evaluation
Part - I

Choose the correct answer
2.	 The ________ diagram gives a logical structure 

of the database graphically.� [Govt. MQP-2019]
(a)	 Entity-Relationship	 (b)	 Entity
(c)	 Architectural Representation
(d)	 Database� [Ans. (a) Entity-Relationship]

3.	 An entity set that does not have enough 
attributes to form primary key is known as
(a)	 Strong entity set	 (b)	 Weak entity set
(c)	 Identity set		  (d)	 Owner set

� [Ans. (b) Weak entity set]

5.	 MySQL belongs to which category of DBMS?
(a)	 Object Oriented	 (b)	 Hierarchical
(c)	 Relational		  (d)	 Network

� [Ans. (c) Relational]

6.	 MySQL is freely available and is open source.
(a)	 True			   (b)	 False

� [Ans. (a) True]
7.	 ________ represents a “tuple” in a relational 

database?
(a)	 Table			   (b)	 Row
(c)	 Column			  (d)	 Object

� [Ans. (b) Row]
8.	 Communication is established with MySQL 

using
(a)	 SQL			   (b)	 Network calls
(c)	 Java 			   (c)	 API's

� [Ans. (a) SQL]

9.	 Which is the MySQL instance responsible for 
data processing?
(a)	 MySQL Client	
(b)	 MySQL Server
(c)	 SQL
(d)	 Server Daemon Program

� [Ans. (b) MySQL Server]

10.	 The structure representing the organizational 
view of entire database is known as __________ 
in MySQL database.
(a)	 Schema 			  (b)	 View
(c)	 Instance			  (d)	 Table

� [Ans. (a) Schema]

Part - II
Short Answers

2.	 List few disadvantages of file processing 
system.

Ans. (i)	 Data Duplication : Same data is used by 
multiple resources for processing, thus 
created multiple copies of same data 
wasting the spaces.

(ii)	 High Maintenance : Access control and 
verifying data consistency needs high 
maintenance cost.

(iii)	 Security : Less security provided to the 
data.

3.	 Define Single and multi valued attributes.
Ans.	Single valued attributes:

A single valued attribute contains only one value 
for the attribute and they don't have multiple 
numbers of values.
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Single Valued Attributes
Attributes Values

Age 3

Roll no 85

Multi valued attributes:
A multi values attribute has more than one value 
for that particular attribute.

Attributes and Values
Attributes Values

Degree B.Tech, MBA
Bank_Account SBI, HDFC

5.	 What are the ACID properties?
Ans.	ACID Properties :� [Govt. MQP-2019]

(i)	 The acronym stands for Atomicity, 
Consistency, Isolation and Durability. 

(ii)	 Atomicity follows the thumb rule “All 
or Nothing”, while updating the data in 
database for the user performing the update 
operation.

(iii)	 Consistency ensures that the changes in 
data value to be constant at any given 
instance. Isolation property is needed 
during concurrent transaction. 

(iv)	 Durability is defined as the system’s ability 
to recover all committed transactions 
during the failure of storage or the system.

9.	 What is Relationship and List its types.
Ans.	There exists a relationship between two tables 

when the foreign key of one table references 
primary key of other table.
Types :
(i)	 One – to – One relationship
(ii)	 One – to – Many relationship
(iii)	 Many – to – Many relationship

10.	 State few advantages of Relational databases.
Ans.	Advantages :

(i)	 High Availability
(iii)	 High Performance
(iv)	 Robust Transactions and Support
(v)	 Ease of Management
(vi)	 Less Cost

Part - III

Explain in Brief Answer

1.	 Explain on Evolution of DBMS.
Ans.	Evolution of DBMS:

(i)	 The concept of storing the data started 
before 40 years in various formats.

(ii)	 In earlier days they have used punched card  
technology to store the data. Then files 
were used.

(iii)	 The file systems were known as predecessor 
of database system.

(iv)	 Various access methods in file system were 
indexed, random and sequential access. 
The file system had more limitations like 

	� Data Duplication : Same data is used by 
multiple resources for processing, thus 
created multiple copies of same data 
wasting the spaces.

	� High Maintenance : Access control and 
verifying data consistency needs high 
maintenance cost.

	� Security : Less security provided to the 
data.

(v)	 So database systems became popular to 
overcome the above limitations of file 
system.

2.	 What is relationship in databases? List its 
types.

Ans.	In ER Model, relationship exists between two 
entities. Three types of relationships are available 
and the Entity-Relationship(ER) diagram is 
based on the three types listed below.
(i)	 One-to-One relationship: One-to-one 

(1:1) relationship is said to exist in a 
relational database design, if 0 or 1 instance 
of entity A is associated with 0 or 1 instance 
of entity B, and 0 or 1 instance of entity B is 
associated with 0 or 1 instance of entity A.

(ii)	 One-to-Many relationship: One-to-
many (1:N) relationship is said to exist in 
a relational database design, for 1 instance 
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of entity A there exists 0 or 1 or many 
instances of entity B, but for 1 instance 
of entity B there exists 0 or 1 instance of  
entity A.

(iii)	 Many-to-Many relationship: Consider 
two entities A and B. many-to-many (M:N) 
relationship is said to exist in a relational 
database design, for 1 instance of entity 
A there exists 0 or 1 or many instances of 
entity B, and for 1 instance of entity B there 
exists 0 or 1 or many instance of entity A.

3.	 Discuss on Cardinality in DBMS.
Ans.	Cardinality is defined as the number of items that 

must be included in a relationship (i.e) number 
of entities in one set mapped with the number of 
entities of another set via the relationship. Three 
classifications in Cardinality are one-to-one, 
one-to-many and Many-to-Many.

Vehicle
1

 

Person Drives
driver

Cardinality

If we consider the current vehicle, the driver is 
operating, then we have one-to-one relationship 
between Person and Vehicle. 

Customer Order
n

Places

Cardinality Relation 1 to n

In the above example, Customer places the 
Order is a one-to-many relationship. Here the 
customer can place multiple orders and the 
order is related to only one customer. 

Student Course
n

register

 Cardinality Relation n to n

The example of many-to-many relationship is 
Students registering the Courses. A student can 
register more than one courses and A course 
can be registered by many students. Hence it is 
many-to-many.

Part - IV

Explain in Detail
2.	 List the basic concepts of ER Model with 

suitable example.
Ans.	ER Modeling basic concepts: The basic concepts 

of ER model consists of 
1.	 Entity or Entity type
2.	 Attributes
3.	 Relationship
These are the general concepts which help to 
create an ER diagram and produce an ER model. 
With the help of these any database design can 
be created and viewed to know the concept in 
that database design. 
1.	 Entity or Entity type :
(i)	 An Entity can be anything a real-world object 

or animation which is easily identifiable by 
anyone even by a common man.

(ii)	 Eg: In a company’s database Employee, HR, 
Manager are considered as entities, where 
each of these entity will be having their 
own attributes. An entity is represented by 
a rectangular box.

Employee Manager
Types of Entity :
(a)	 Strong Entity
(b)	 Weak Entity
(c)	 Entity Instance

2.	 Attributes:  
An attribute is the information about that entity 
and it will describe, quantify, qualify, classify, 
and specify and entity. An attribute will always 
have a single value, that value can be a number 
or character or string.
Types of attributes :
(i)	 Key Attribute
(ii)	 Simple Attributes
(iii)	 Composite Attributes
(iv)	 Single Valued Attribute
(v)	 Multi Valued Attribute
3.	 Relationship Type: 
In ER Model, relationship exists between two 
entities. Three types of relationships are available 
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and the Entity- Relationship(ER) diagram is 
based on the three types listed below. 
(i)	 One-to-One relationship: Consider 

two entities A and B. one-to-one (1:1) 
relationship is said to exist in a relational 
database design, if 0 or 1 instance of entity 
A is associated with 0 or 1 instance of 
entity B, and 0 or 1 instance of entity B is 
associated with 0 or 1 instance of entity A.

(ii)	 One-to-Many relationship: Consider 
two entities A and B. one-to-many (1:N) 
relationship is said to exist in a relational 
database design, for 1 instance of entity 
A there exists 0 or 1 or many instances of 
entity B, but for 1 instance of entity B there 
exists 0 or 1 instance of entity A.

(iii)	 Many-to-Many relationship: Consider 
two entities A and B. many-to-many (M:N) 
relationship is said to exist in a relational 
database design, for 1 instance of entity 
A there exists 0 or 1 or many instances of 
entity B, and for 1 instance of entity B there 
exists 0 or 1 or many instance of entity A.

In reality one-to-one are in less usage, where as 
one-to-many and many-to-many are commonly 
used. However in relational databases, many-
to-many are converted into one-to-many 
relationships.

3.	 Discuss in detail on various types of attributes 
in DBMS.� [QY-2019]

Ans.	Types of attributes :
1. 	 Key Attribute
2.	 Simple Attributes 
3.	 Composite Attributes 
4.	 Single Valued Attribute
5.	 Multi Valued Attribute

1.	� Key Attribute : Generally a key attribute 
describes a unique characteristic of an 
entity.

2.	 Simple Attribute :
(i)	 The simple attributes cannot be separated it 

will be having a single value for their entity. 

(ii)	 Ex: Let us consider the name as the attribute 
for the entity employee and here the value 
for that attribute is a single value.

Employee

First name

Name

Last name

Simple Attribute

3.	 Composite Attributes : 
(i)	 The composite attributes can be subdivided 

into simple attributes without change in the 
meaning of that attribute.

(ii)	 Ex: In the above diagram the employee 
is the entity with the composite attribute 
Name which are sub-divided into two 
simple attributes first and last name.

4.	 Single Valued Attributes : 
(i)	 A single valued attribute contains only one 

value for the attribute and they don’t have 
multiple numbers of values.

(ii)	 Ex: Age- It is a single value for a person 
as we cannot give n number of ages for a 
single person,therefore it is a single valued 
attribute.

Single Valued Attributes
Attribute Values

Age 3
Roll no 85

	� In the above table are the some examples 
for single valued attributes.

Person

Degree

Single Valued Attributes
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5.	 Multi Valued Attributes :
(i)	 A multi valued attribute has more than one value for that particular attribute. 
(ii)	 Ex: Degree - A person can hold n number of degrees so it is a multi-valued attribute.

Attributes and Values
Attribute Values

Degree B.Tech, MBA
Bank_Account SBI, HDFC

government exam questions and answers
Choose the Correct Answer� 1 MARK

1.	 A key with more than one attribute to identify rows originally in a table is called  � [QY-2019]
(a)	 Candidate key				    (b)  Foreign key
(c)	 Primary key					     (d)  Composite key� [Ans. (d) Composite key]

4.	 The horizontal entity in a table is known as� [Mar-2020]
(a)	 Key						      (b)  Record		
(c)  Table						      (d)  Column� [Ans. (b) Record]

6.	 ________ uniquely identifies the row in Database table.� [Sep-2020]
(a)	 Foreign key					     (b)  Super key	
(c)	 Primary key					     (d)  Composite key� [Ans. (c) Primary key]

Very Short Answers� 2 MARKS

1.	 What is primary key?� [Mar-2020]

Ans.	This key of relational table identifies each record in the table in a unique way.


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